
ESA - official use 

 

esac
European Space Astronomy Centre (ESAC)

European Space Agency (ESA)
Camino Bajo del Castillo s/n
Urb. Villafranca del Castillo

28692 Villanueva de la Canada - Madrid
SPAIN

CASSIS  CO-REGISTERED  SUPER-
RESOLUTION IMAGES AND MADNET-
DERIVED DIGITAL TERRAIN MODELS
OF OXIA PLANUM OF MARS

Prepared by UCL (Yu Tao, Jan-Peter Muller)
Date of Issue 14/12/2021



ESA UNCLASSIFIED - For Official Use

Reason for change Issue Revision Date

Initial version 1 0 14/12/2021

Issue 1 Revision 0

Reason for change Date Pages Paragraph(s)

Initial version 14/12/2021 All All

Page 2/16



ESA UNCLASSIFIED - For Official Use

TABLE OF CONTENTS:

1.  Introduction..........................................................................................................................................................................4
1.1 Instrument and Datasets.......................................................................................................................................................4
1.2 Abbreviations and Acronyms...............................................................................................................................................6
1.3 Reference and Applicable Documents.................................................................................................................................7
2. Scientific Objectives..............................................................................................................................................................8
2.1 Acknowledgements..............................................................................................................................................................8
3. Data Product Generation........................................................................................................................................................9
3.1 Product Overview..............................................................................................................................................................10
3.2 SRR and SRR-DTM Product Specification........................................................................................................................12
3.3 Product Example and Usage..............................................................................................................................................12
4. Known Issues.......................................................................................................................................................................14
5. Software............................................................................................................................................................................... 16

Page 3/16



ESA UNCLASSIFIED - For Official Use

1.  INTRODUCTION 

High-resolution  digital  terrain  models  (DTMs)  and  their  corresponding  terrain-corrected
orthorectified  images  (ORIs)  are  probably  two  of  the  most  fundamental  and  intuitive
resources for studying the Martian surface. Apart from the globally available lower resolution
(463 m/pixel) Mars Orbiter Laser Altimeter (MOLA) DTM, higher resolution Mars DTMs are
typically produced from the 12.5 – 50 m/pixel Mars Express High Resolution Stereo Camera
(HRSC) images, the 6 m/pixel Mars Reconnaissance Orbiter (MRO) Context Camera (CTX)
images, the ~4.6 m/pixel (4 m/pixel nominal resolution) ExoMars Trace Gas Orbiter (TGO)
Colour  and Stereo  Surface  Imaging  System (CaSSIS)  images,  and  the  ~30 cm/pixel  (25
cm/pixel nominal resolution) MRO High Resolution Imaging Science Experiment (HiRISE)
images. The DTM products derived from these imaging sources often have different effective
resolutions and spatial  coverage,  depending on the properties of the input images and the
DTM  retrieval  methods,  which  include  traditional  photogrammetric  methods,
photoclinometry methods, and deep learning-based methods.

It has been a common situation that DTMs derived from a particular imaging dataset can only
achieve  a lower,  or  at  the best,  similar  effective  spatial  resolution  compared to  the input
images,  due  to  the  various  approximations  and/or  filtering  processes  introduced  by  the
photogrammetric  or  photoclinometric  pipelines.  With  recent  successes  in  deep  learning
techniques, it has now become practical to improve the effective resolution of an image using
super-resolution  restoration  (SRR)  networks  (Tao  et  al.,  2021a),  retrieving  pixel-scale
topography using single-image DTM estimation  (SDE) networks (Tao et  al.,  2021b),  and
eventually, combining the two techniques to potentially produce subpixel-scale topography
from only a single-view input image (Tao et al., 2021c).

In this work, we have combined the use of SRR and SDE to boost the effective resolution of
optical  single-image-based DTMs to  subpixel-scale.  The  in-house  implementations  of  the
MARSGAN (multi-scale adaptive-weighted residual super-resolution generative adversarial
network) SRR system (ibid) and the MADNet (multi-scale generative adversarial U-net based
single-image DTM estimation) SDE system (ibid) are employed for this work. The study site
is within the 3-sigma ellipse of the Rosalind Franklin ExoMars rover’s planned landing site
(centred near 18.275°N, 335.368°E) at  Oxia Planum. We use the 4 m/pixel TGO CaSSIS
“PAN” band images as the input dataset. We apply MARSGAN SRR to the original CaSSIS
and HiRISE images, and subsequently, we apply MADNet SDE to the resultant 1 m/pixel
CaSSIS  SRR  to  produce  CaSSIS  SRR-DTMs  at  2  m/pixel.  Qualitative  and  quantitative
assessments for the resultant CaSSIS SRR-DTMs are shown in (Tao et al., 2021c).

1.1 Instrument and Datasets
TGO CaSSIS is a moderately high-resolution, multispectral (from ~500 nm to ~950 nm for
visible and near-infrared (NIR)), push-frame (an intermedium of a line scan camera and frame
camera) stereo imager, with the goal of extending the coverage of the MRO HiRISE camera
and to produce moderately high-resolution DTMs of the Martian surface. CaSSIS provides
colour images consisting of the “BLU” band (centred at 499.9 nm for blue-green), the “PAN”
band (centred at 675.0 nm for orange-red), the “RED” band (centred at 836.2 nm for NIR),
and the “NIR” band (centred at 936.7 nm for NIR). CaSSIS images are typically sampled at 4
m/pixel  nominal  spatial  resolution (~4.6 m/pixel  effective spatial  resolution) with a swath
width  of  about  9.5  km and  a  swath  length  of  about  30  –  40  km.  Due  to  the  non-sun-
synchronous orbit and the 74˚ inclination angle, CaSSIS is able to image sites at different
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local times of different seasons, making CaSSIS images an ideal dataset for studying Martian
surface changes. Up until 28 August 2021, CaSSIS images covered ≈4.3% of the Martian
surface.

In this  work, we experiment  with the TGO CaSSIS PAN band images  over the Rosalind
Franklin ExoMars rover’s landing site at Oxia Planum. Up until 28 August 2021, CaSSIS has
100% coverage for the 1-sigma landing ellipses, about 92% coverage for the 3-sigma landing
ellipses, and about 67% for the ExoMars RSOWG team’s geological characterisation area of
the landing site.  Table 1 provides a list of the test CaSSIS images (selected for non-repeat),
available overlapping HiRISE PDS DTMs and ORIs that are used for comparison/evaluation
in (Tao et al., 2021c). It should be noted that both of the HiRISE PDS DTMs and the resultant
CaSSIS MADNet DTM and CaSSIS SRR MADNet DTM mosaics have been 3D co-aligned
with respect to the cascaded 12 m/pixel CTX and 25 m/pixel HRSC MADNet DTM mosaics
(Tao et al., 2021d) that are both available on this ESA-PSA GSF, which themselves are co-
aligned  with  the  United  States  Geological  Survey  (USGS)  MOLA areoid  DTM v.2  (see
https://astrogeology.usgs.gov/search/details/Mars/GlobalSurveyor/MOLA/
Mars_MGS_MOLA_DEM_mosaic_global_463m/cub).  Figure 1 shows an overview map of
the test CaSSIS images (co-registered with the CTX and HRSC ORIs) superimposed on the
CTX MADNet DTM mosaic.

Table 1. List of the input CaSSIS images (in the order of the image co-registration process – reverse order of the
image and DTM mosaicing process), validation HiRISE PDS DTMs, and the correspondng HiRISE PDS ORIs,
over the 3-sigma ellipses of the ExoMars Rosalind Franklin rover’s landing site at Oxia Planum.

Input CaSSIS image ID Overlapping HiRISE PDS DTM ID HiRISE PDS ORI ID
MY35_007250_019_0 - -
MY35_007623_019_0 - -
MY35_008742_019_0
(cropped)

- -

MY34_003806_019_2 DTEEC_039299_1985_047501_1985_L01 ESP_039299_1985_RED_A_01_ORTHO
MY34_004925_019_2 DTEEC_036925_1985_037558_1985_L01 ESP_036925_1985_RED_A_01_ORTHO
MY35_009481_165_0
(cropped)

- -

MY35_013584_163_0
(cropped)

DTEEC_042134_1985_053962_1985_L01 ESP_042134_1985_RED_A_01_ORTHO

MY34_005664_163_2 - -
MY34_005012_018_2 DTEEC_037070_1985_037136_1985_L01 ESP_037070_1985_RED_A_01_ORTHO
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Figure 1. Overview map of the 9 test CaSSIS images (co-registered with the CTX and HRSC
ORIs),  superimposed  on  the  CTX  MADNet  DTM  mosaic  (baseline  reference),  over  the
ExoMars Rosalind Franklin rover’s landing site (1-sigma ellipse: red; 3-sigma ellipse: blue) at
Oxia Planum (centred at 18.239°N, 24.368°W).

1.2 Abbreviations and Acronyms
DTM Digital Terrain Model
DUG Data User Guide
ESA European Space Agency
GIS Geographic Information System
TGO Trace Gas Orbiter
CaSSIS Colour and Stereo Surface Imaging System
HRSC High-Resolution Stereo Camera
CTX Context camera
HiRISE High Resolution Imaging Science Experiments
MOLA Mars Orbiter Laser Altimeter
NASA National  Aeronautics  and  Space  Administration  (United  States)  
ORI OrthoRectified Images
PSA Planetary Science Archive
UCL University College London
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Page 7/16

https://doi.org/10.3390/rs13163270
https://doi.org/10.3390/rs13214220
https://doi.org/10.3390/rs13091777


ESA UNCLASSIFIED - For Official Use

2. SCIENTIFIC OBJECTIVES

All results shown here are made for the Rosalind Franklin ExoMars 2022 rover’s landing site
at Oxia Planum. This site is a 200 km wide clay bearing plain centred on 18.239°N, 24.368°W
inside the  United  States  Geological  Survey (USGS)’s  Oxia Palus  (MC-11) quadrangle  of
Mars. The landing site area straddles the dichotomy boundary of Mars, which separates the
northern lowlands from the southern highlands. The site slopes towards the north and hosts
mineralogical (iron-magnesium rich clay minerals) and geomorphological evidence of liquid
water in the ancient  past,  which motivated  the choice of this  site  for this  mission whose
principal objective is to search for potential biomarkers indicating past life on Mars.

2.1 Acknowledgements
Users  are  requested  to  acknowledge  the  dataset  by  mentioning  it  in  any  relevant  figure
captions and within acknowledgement within their publications to cite both the DOI of the
dataset and the paper describing the processing system, assessment, and mosaic generation:

Tao, Y.; Conway, S.J.; Muller, J.-P.; Putri, A.R.D.; Thomas, N.; Cremonese, G. Single Image
Super-Resolution  Restoration  of  TGO  CaSSIS  Colour  Images:  Demonstration  with
Perseverance Rover Landing Site and Mars Science Targets. Remote Sens. 2021, 13,  1777.
https://doi.org/10.3390/rs13091777

Tao,  Y.;  Muller,  J.-P.;  Xiong,  S.;  Conway,  S.J.  MADNet  2.0:  Pixel-Scale  Topography
Retrieval  from  Single-View  Orbital  Imagery  of  Mars  Using  Deep  Learning. Remote
Sens. 2021b, 13, 4220. https://doi.org/10.3390/rs13214220

Tao,  Y.;  Xiong,  S.-T.;  Muller,  J.-P.;  Michael,  G.;  Conway,  S.J.;  Paar,  G.;  Thomas,  N.;
Cremonese,  G.  Subpixel-Scale  Topography  Retrieval  of  Mars  Using  Single-Image  DTM
Estimation and Super-Resolution Restoration. Remote Sensing 2021c, in review.

Tao, Y.; Muller, J.-P.; Conway, S.J.; Xiong, S. Large Area High-Resolution 3D Mapping of
Oxia  Planum:  The  Landing  Site  for  the  ExoMars  Rosalind  Franklin  Rover. Remote
Sens. 2021d, 13, 3270. https://doi.org/10.3390/rs13163270

The research leading to these results receiving funding from the UKSA Aurora programme
(2018–2021) under grant ST/S001891/1, as well  as partial  funding from the STFC MSSL
Consolidated Grant ST/K000977/1.
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3. DATA PRODUCT GENERATION

The processing core of this work is the deep learning based MARSGAN SRR and MADNet
SDE systems described in (Tao et al., RS, 2021a-c). MARSGAN and MADNet are based on
the  relativistic  GAN  framework  that  involves  training  of  a  generator  network  and  a
discriminator network in parallel. For the MARSGAN SRR, the generator network is trained
to produce potential  SRR estimates,  whilst the discriminator network is trained in parallel
(and updated in an alternating manner with the generator network) to estimate the probability
of the given training  HR images being more realistic  than the generated  SRR images on
average. Whereas for MADNet SDE, the generator network is trained to produce per pixel
relative heights, and the discriminator network is trained to distinguish the predicted heights
from the ground-truth heights.

For the MARSGAN generator  network,  we employ a feed-forward residual  convolutional
neural network (CNN) architecture, consisting of twenty-three Adaptive Weighted Residual-
in-Residual  Dense  Blocks  (AWRRDBs),  followed  by  an  Adaptive  Weighted  Multi-Scale
Reconstruction  (AWMSR)  block.  Each  of  the  AWRRDBs  contains  eleven  independent
weights, three DCBs, and additive noise inputs on top of the residual-in-residual structure. For
the  MADNet  generator  network,  we  employ  a  fully  convolutional  U-net  architecture,
consisting of four stacks of DCBs as the encoder and five stacks of Up-Projection Blocks
(UPBs)  as  the  decoder.  MARSGAN  and  MADNet  use  a  similar  discriminator  network
architecture as detailed in (Tao et al., RS, 2021a, 2021b). Simplified network architectures of
the MARSGAN SRR and MADNet SDE networks that are used in this work are shown in
Figure 2.
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Figure 2. Network architectures of MARSGAN and MADNet.

Archive Format and Content
3.1 Product Overview
A variety of novel products have been generated including nine single-strip CaSSIS PAN
band 1 m/pixel SRR images and 2 m/pixel SRR-DTMs, a brightness and contrast corrected 1
m/pixel CaSSIS SRR greyscale image mosaic, a 1 m/pixel CaSSIS SRR colour image mosaic
(colourised  using  HRSC colour  by G.  Michael  of  the  Free  University  Berlin,  due to  the
CaSSIS colour bands being much narrower than the PAN band), an 8 m/pixel CaSSIS DTM
mosaic, and a 2 m/pixel CaSSIS SRR-DTM mosaic, over the 3-sigma ellipses of the ExoMars
Rosalind Franklin rover’s planned landing site at  Oxia Planum.  Figure 3 shows overview
maps  of  the  original  4  m/pixel  CaSSIS  NPB (NIR-PAN-BLU)  band  colour  images,  the
resultant 1 m/pixel CaSSIS PAN band SRR single-strip images, 1 m/pixel CaSSIS SRR image
mosaic,  1  m/pixel  CaSSIS  SRR  image  mosaic  with  HRSC  colour,  8  m/pixel  CaSSIS
MADNet  DTM mosaic  and  shaded  relief  image  (330˚  azimuth,  30˚  altitude,  2×  vertical
exaggeration),  and the  2  m/pixel  CaSSIS SRR MADNet  DTM mosaic  and shaded  relief
image  (330˚  azimuth,  30˚  altitude,  2×  vertical  exaggeration).  It  should  be  noted  that  all
CaSSIS SRR, MADNet DTM, and SRR MADNet DTM results are produced using the 4
m/pixel CaSSIS PAN band images, the 4 m/pixel CaSSIS NPB colour images that are shown
in Figure 3 are for information only to show their narrower coverage and the reason why they
are not used in this work (gaps between the adjacent colour images).
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Figure  3. Overview maps of the 4 m/pixel CaSSIS NPB (NIR-PAN-BLU) band colour images,  the resultant 1
m/pixel CaSSIS PAN band SRR single-strip images, 1 m/pixel CaSSIS SRR image mosaic, 1 m/pixel CaSSIS SRR
image mosaic with HRSC colour, 8 m/pixel CaSSIS MADNet DTM mosaic, shaded relief image of the 8 m/pixel
CaSSIS MADNet DTM mosaic, 2 m/pixel CaSSIS SRR MADNet DTM mosaic, and shaded relief image of the 2
m/pixel CaSSIS SRR MADNet DTM mosaic, over the 1-sigma (red) and 3-sigma (blue) ellipses of the ExoMars
Rosalind Franklin rover’s planned landing site at Oxia Planum.

The above results (SRR image and SRR-DTM) at a very high resolution with uniform quality
and consistency are being published through the ESA GSF. They are spatially co-registered
and vertically co-aligned with respect to the cascaded HiRISE, CTX, and HRSC ORIs and
DTM mosaics that are described in (Tao et al.,  RS, 2021c, 2021d), which themselves are
accurately  co-registered  with  the  ESA/DLR/FUB  HRSC  MC-11W  level  5  ORI  mosaic
(available  at  http://hrscteam.dlr.de/HMC30)  and  vertically  co-aligned  with  the
aforementioned  USGS  MOLA  areoid  DTM.  We  use  identical  map  projection  system
(Equidistant Cylindrical) and map projection parameters as used in the ESA/DLR/FUB HRSC
MC-11W level 5 ORI and DTM products. These other products are also available through the
ESA-PSA GSF at 
https://www.cosmos.esa.int/web/psa/ucl-mssl_oxia-planum_hrsc_ctx_hirise_madnet_1.0 
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3.2 SRR and SRR-DTM Product Specification
• Projection: Equirectangular (aka Equidistant Cylindrical) 1

• Mars radius reference: MOLA aeroid (da) 2

Product Filename Image
size
(pixels)

Resolution
(m/pixel)

Bit-
depth

CaSSIS PAN band SRR
image mosaic (greyscale)

cassis_pan_srr_mosaic.tif 69097 x
85710

1 Byte

CaSSIS SRR image
mosaic (with HRSC

colour)

cassis_pan_srr_mosaic_hrsc
_rgb_colour.tif

69097 x
85710

1 Byte

CaSSIS MADNet DTM
mosaic

CaSSIS-MADNet-DTM-
mosaic-ORDERED.tif

8330 x
10428

8 Float32

CaSSIS SRR MADNet
DTM mosaic

CaSSIS-SRR-MADNet-
DTM-mosaicv2.tif

34197 x
42719

2 Float32

3.3 Product Example and Usage
The DTM and SRR image file are in GeoTiff format and can be opened by many different
GIS/image processing systems such as ArcGIS, QGIS, and ENVI. Projection and mapping
information is embedded in the tags of the Geotiff file. The best way to visually inspect a
DTM is by using a colourised hill-shaded display. The following instructions show how to
create a colourised hill-shaded view of the DTM product in QGIS.

1. Import the DTM via: Layer -> Add layer -> Add Raster Layer -> Select the Raster
dataset(s) -> Add -> Close

2. Create shaded relief  image:  left  click to select the DTM -> Raster -> Analysis  ->
Hillshade  ->  Select  the  illumination  parameters  (e.g.,  z=2,  azimuth=330,
elevation=30) under “Hillshade”  click “…” -> save to file -> choose a filename and
end with .tif -> OK -> run -> close

3. Adjust the display setting of the shaded relief image: right click the hill-shaded relief
image  ->  Properties  ->  Symbology  ->  under  “Color  Rendering”  select  “Blending
mode” -> “Overlay” -> adjust “Brightness” as “-60” -> Apply -> OK.

4. Adjust  the  display  setting  of  the  DTM:  right  click  the  DTM  ->  Properties  ->
Symbology  ->  under  “Band  Rendering”  select  “Render  type”  as  “Singleband
pseudocolor” -> under “Min/Max Value Settings” select Min/Max -> under “Color
ramp” select a colour ramp then select “Invert Color Ramp” -> click “Classify” ->
Apply -> OK

Other important points to note:
1. Ensure you place the hillshaded relief  image layer in front of the colourised DTM

layer.
2. Do not use transparency for the hillshaded relief  image layer as “Overlay” display

mode is already selected.
3. You can use z=3 if a strong hill-shading effect is required.

1 https://en.wikipedia.org/wiki/Equirectangular_projection 
2   https://astrogeology.usgs.gov/search/map/Mars/GlobalSurveyor/MOLA/  
Mars_MGS_MOLA_DEM_mosaic_global_463m 
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4. Always create a group for the colourised DTM and hillshaded relief image and use the
group icon to toggle display of the colourised hillshaded DTM.
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4. KNOWN ISSUES

In this work, we have demonstrateds that DTM production, at 2 times higher resolution than
the original input image, is feasible from single-view Mars orbital images (i.e., CaSSIS) using
deep  learning  based  SRR and  SDE methods.  We observe  significant  improvements  both
qualitatively and quantitatively from the resultant MADNet DTMs that use MARSGAN SRR
compared to the MADNet DTMs that do not use MARSGAN SRR. The improvement  of
DTM resolution is visually about 4 times but quantitatively better than 4 times, even though
the improvement of the images themselves via MARSGAN SRR is visually and quantitatively
less than 4 times (Tao et al., RS, 2021c). We believe that most of the improvement of the
DTM resolution comes from the improved image resolution, and the “extra” improvement
comes from the reduction of image noise which leads to better performance of the MADNet
SDE process. 

While the improvement in the DTM resolution is encouraging, the coupled SRR and SDE
process slightly lowers the accuracy (RMSE difference 0.323 m) and structural  similarity
(SSIM  difference  0.049)  for  the  resultant  CaSSIS  DTM,  which  implies  higher  DTM
uncertainty.  This  quantitative  evaluation  also  agrees  with  our  visual  inspection  that
topographic  features  in  the  CaSSIS  SRR  MADNet  DTM  are  subject  to  minor
overshoot/undershoot or shape differences, compared to the HiRISE image and HiRISE SRR
MADNet DTM, even though they look plausible when compared to the original CaSSIS and
CaSSIS SRR image. This is due to the fact that MARSGAN SRR attempts to give the most
realistic  HR estimation  of  the  fine-scale  features  but  cannot  “invent”  the  HR features  or
textures that are not visible from the input image. Such HR estimation is based on the existing
information in the input image that is partially subject to interference from sensor/atmosphere
noise and/or incompletely recorded pixel-scale information, which could consequently give
inaccurate or erroneous SRR input to the follow-up MADNet SDE process.

Figure 4 shows input images and shaded relief images of the output DTMs of an exemplar
area over a subarea (south-west corner) of a small crater (centred at 24.3350˚W, 18.0716˚N)
of the test site at Oxia Planum. The “red arrows” show an example of the CaSSIS features that
are considered inaccurately super-resolved, where the “real” feature appears to be wider in the
25 cm/pixel HiRISE image, compared to the narrower appearance in the 1 m/pixel CaSSIS
SRR image, and consequently,  such features are inaccurately interpreted in 3D, where the
“real” feature appears to be flatter and thicker in the 50 cm/pixel HiRISE MADNet DTM,
compared to their steeper and thinner appearance in the 2 m/pixel CaSSIS SRR MADNet
DTM. The “green arrows” show a counter example of the same features that are considered
more accurately super-resolved, where the “real” feature appears to have a very similar width
and shape in the HiRISE image and CaSSIS SRR image, and subsequently, results in a fairly
similar  appearance  of  its  3D shape and slope in  the shaded relief  images  of  the  HiRISE
MADNet DTM and CaSSIS SRR MADNet DTM. This example demonstrates the resultant
CaSSIS  SRR  MADNet  DTM  contains  a  mixture  of  reliable  topography  as  well  as  less
accurate topography, though with obviously higher effective resolution.
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Figure 4. Images and shaded relief images of the corresponding DTM products showing a portion (south-west
corner) of a small crater (centred at 24.3350˚W, 18.0716˚N) of the test site at Oxia Planum. 1 st row: 4 m/pixel
CaSSIS PAN band image (MY35_009481_165_0_PAN), 1 m/pixel CaSSIS PAN band SRR image, and 25 cm/pixel
HiRISE RED band PDS ORI (ESP_039299_1985_RED_A_01_ORTHO); 2nd row: shaded relief images (using similar
illumination parameters as the HiRISE PDS ORI, i.e., 225˚ azimuth, 30˚ altitude, 2× vertical exaggeration) of the 8
m/pixel CaSSIS MADNet DTM, 2 m/pixel CaSSIS SRR MADNet DTM, and 50 cm/pixel HiRISE MADNet DTM.
Red arrows point to an exemplar of the super-resolved features and their topography that are considered less
accurate compared to the HiRISE images and DTMs. Green arrows point to an exemplar of the super-resolved
features and their topography that are considered more accurate compared to the HiRISE images and DTMs.
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5. SOFTWARE

The processing  uses  the  UCL’s  in-house  MARSGAN SRR and  MADNet  SDE software.
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